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Range Names 

Naming Cells and Areas 

 

Cell ranges are normally referred to by their cell address, e.g. A1:A10 or 
S36:W50. However, Microsoft Excel allows you to assign names to 
individual cells and ranges of cells. This has three advantages: 

 Worksheets are easier to interpret as names are used in formulae instead 
of cell addresses; 

 Navigation about the worksheet is quicker and easier; 

 Named ranges are automatically absolute when used in formulae. When 
you copy a formula that uses a named range the range does not change 
when it is copied, unlike a relative range that does change when it is 
copied.  

Naming a Cell or Range of Cells 

First select the required cell or range of cells and then choose 
Insert|Name|Define from the main menu. You will then see the following 
dialog box: 

 

Type in the name that you want to assign to the selected cell and click on 
the OK button. This name will now be stored permanently with the 
workbook and will refer to the cell. 

Another way of naming a cell is to select the cell, click in the name box on 
the formula bar, type the name you want for the cell and then press Enter.  
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Creating a Named Range 

You can get Excel to do some of the hard work for you by creating the 
range names based on the headings in the columns or rows of the 
worksheet.   

In the example below we have selected the text in column A and the 
corresponding numbers in column B.  When you go to the Insert menu 
and choose Name and then Create the Create Names dialog box 
appears.  Choose the tick box that represents the position of the text you 
want to use as your names and choose OK.  Excel names all the ranges 
for you!  
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Using a Range Name  

Worksheet navigation 

If you have named any cells, you can use the names for quick worksheet 
navigation by using the F5 GoTo function. When you press F5 the 
following dialog box is displayed. Any range names you have assigned 
will be displayed in the list. By simply double-clicking on the name you 
require, your active cell will become the first cell in the named range. 

You can also select named ranges by using the Name box at the left end 
of the formula bar. Click on the drop-down arrow to the right of the name 
box and choose the name you require. The range will now be highlighted. 

 Using the down arrow on the name box 

In formulae 

To use a range name in a formula, build the formula in the normal way; 
however, instead of clicking on the cells that will make up the formula, 
type in the name of the range to be used. Microsoft Excel will accept any 
valid range name into a formula and will still carry out all calculations 
correctly. 

You can also add names to formulae by selecting from a list of available 
names; this has the benefit of ensuring accuracy when creating your 
formulae. To use this method begin your formula as normal. When you 
want to insert a name, press F3. You will see a list of the available 
names; choose the names you need in your formula and continue. 

Applying names 

When you create or define names, they are not automatically distributed 
to existing formulae on the worksheet. In this case you need to apply the 
name. 

First make your selection. If you choose a single cell anywhere on the 
sheet, the names you choose will be applied to all cells, wherever they 
are located on the worksheet, that refer to the named cells in their 
formulae. If you select a range of cells, only those cells will have the 
range names applied to them. 

Having selected the cells, select Insert|Name|Apply from the main menu. 
Click on the range names you wish to apply to your selection, and then 
click on OK. Your formulae will now use cell names rather than cell 
locations. 
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Assigning a Value to a Name 

A name can refer to a value rather than a cell or range location. This is 
useful where formulae in your application need to refer to constant 
values, e.g. discount rates, tax rates, dates, times, etc., but where you 
donôt want the constants displayed. 

To create a name that refers to the VAT rate choose any cell on the 
worksheet and select Insert|Name|Define from the main menu. Type in 
the name VAT in the name box and tab down to the Refers To box. Type 
in 17.5%. Click on the OK button. 

 

This name can now be used in any formula to calculate VAT. If the VAT 
rate were to alter, choose Insert|Name|Define and amend the value in the 
Refers To box. All formulae using the name will be updated and the new 
answers calculated. 

Workbook v. Worksheet Names 

When you create a name it will be available to all worksheets in the 
current workbook. If, however, you want a name to be available only to a 
specific sheet, you can create a sheet level name. To do this select the 
cells and then choose Insert|Name|Define from the main menu. Type in 
the name of the sheet you are working on followed by an exclamation 
mark; then type in the name of the range. 

For example, to create a named range called Sales, available only on the 
January worksheet, you would assign the name January!Sales. 
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Sharing Workbooks 

About Shared Workbooks 

You can allow others to look at and edit a workbook at the same time. 
And see each others changes by creating a shared workbook ï this must 
be in a public area of the network.  You can give everyone the same 
access to a workbook or limit the access by protecting the workbook. 

1 On the Tools menu, click Share Workbook, and then click the Editing 
tab. 

2 Select the Allow changes by more than one user at the same time check 
box, and then click OK. 

 

 

3 When prompted, save the workbook. 

 

On the File menu, click Save As, and then save the shared workbook on 
a network location where other users can gain access to it. 
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Maintain the change history for a workbook 

 

When you keep the change history for a workbook, Microsoft Excel also 
turns on workbook sharing. Some Microsoft Excel commands and 
operations are not available in a shared workbook.  

 

1 On the Tools menu, click Share Workbook, and then click the 
Advanced tab. 

 

 

 

2 Under Track changes, click Keep change history for, and then type the 
number of days you want to maintain the change history in the Days box. 

Notes 

 The change history includes information about how users resolved 
conflicting changes to the workbook, including the data from changes that 
were discarded. 

 Each time you close the workbook, Microsoft Excel erases any part of the 
stored change history that is older than the number of days you specified. 
The actual changes are retained. 
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Determine how often to update a shared workbook 

Each user of a shared workbook can set independent options for how 
often to receive other users' changes. 

 To see other users' changes each time you save the shared workbook, 
click When file is saved under Update changes. 

 To view other users' changes periodically, click Automatically every  
under Update changes, type how often you want to get updates in the 
Minutes box, and then click Just see other users' changes. To save 
the shared workbook each time you get an update so that other users can 
see your changes, click Save my changes and see others' changes. 

 

Determine whether to review conflicting changes to a shared 
workbook 

Each user of a shared workbook can set independent review options. 

 To review each conflicting change and decide which changes to keep 
when you save the workbook, click Ask me which changes win under 
Conflicting changes between users. 

 To replace any conflicting changes with your own changes each time you 
save, click The changes being saved win. 

 

Note  If you don't want to see the Resolve Conflicts dialog box when 
you save a shared workbook, click The changes being saved win. 

 

Using a Shared Workbook 

Setting the User Name 

When you make changes to a shared workbook, Microsoft Excel uses 
your user name to identify your work. To set your user name, click 
Options on the Tools menu, and then click General. Type your user 
name in the User name box. 

Comments 

If more than one user adds a comment to the same cell in a shared 
workbook, the text of all saved comments for the cell appears when each 
user saves the shared workbook. 

By default, if changes you are saving conflict with changes saved by 
another user, Microsoft Excel displays the Resolve Conflicts dialog box 
so that you can decide whether to save your changes or keep the 
changes made by others.  
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View the history of all changes to a workbook 

You can view a complete list of changes to the workbook, including the 
names of the users who made the changes, data that was deleted or 
replaced, and information about conflicting changes.  

1. On the Tools menu, point to Track Changes, and then click Highlight 
Changes. 

 

 

 

2. Make sure the Track changes while editing check box is selected. This 
check box turns on workbook sharing and the change history.  

3. Select the When check box, and then click All in the When box. 

4. To view the changes on a separate History worksheet that lets you filter 
the information to find the changes you want, select the List changes on 
a new sheet check box. 

5. To view the changes highlighted on the worksheet and display details 
when you rest the pointer over a changed cell, select the Highlight 
changes on screen check box. 

6. Click OK, and if prompted, save the workbook. 

Notes 

 The List changes on a new sheet check box becomes available only after 
the workbook has been saved with the Track changes while editing check 
box selected. 

 If you save the workbook, Microsoft Excel removes the History 
worksheet. To view the History worksheet after you save, you must 
repeat this procedure to display it again. 

 If you list the changes on a new sheet, you can find specific types of 
changes by filtering the list. On the History worksheet, click the arrow to 
the right of the column label for a column that has information you want to 
find, and select the type of data you want to display in that column. You 
can refine your search by filtering other columns. 

 Microsoft Excel does not update the History worksheet automatically. To 
update the History worksheet so that it includes changes made and 
saved since the last time you displayed it, save the workbook and then 
repeat steps 1 through 3 to display the History worksheet again. 
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 Compare & Merge workbooks  

To enable Compare and Merge you must follow these rules: 

 You can only merge workbooks if they are Shared the Compare and 
Merge option is greyed out if the workbook is not shared.   

 They should also be stored in the same folder and each must be given a 
different name.  

 The file you wish to compare and merge cannot be open.   The following 
message will display 

 

 

 

 The merging workbook must be a copy of the original that has been 
renamed and edited.  The following error message will display. 

 

 

1. Open the copy into which you want to merge changes.  

2. Ensure that [Shared] appears in the tile bar.  If not proceed as follows: 

a. From the Tools menu choose Track Changes, Highlight changes 

b. This will turn on sharing 

c. If prompted, save the workbook 

3. On the Tools menu, click Compare and Merge Workbooks.  

4. If prompted, save the workbook.  

5. In the Select Files to Merge into Current Workbook dialog box, click a 
copy that has changes to be merged, and then click OK.  

6. To merge more than one copy at the same time, hold down CTRL or 
SHIFT and click the file names, and then click OK. 
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Styles 

Styles are predefined formatting options that can be applied to a cell or a 
range of cells quickly and easily. Examples of styles that already exist 
within Excel 2000 are those which apply the currency, comma and 
percentage number formats. These styles can be applied by clicking on 
the relevant toolbar buttons. 

 

Rather than applying to a cell such things as font style, colour, number 
format, alignment, etc. in separate moves, you can apply a style which 
would set all of these in one go. 

 

Styles are stored within a workbook. If you want a style to be available to 
other workbooks it will need to be merged into them. 

Creating a Style 

The easiest way to create a new style is to provide Excel 2000 with an 
example of the formatting you want and then to give this formatting a 
name. From then on, the style will be available to apply to other cells. 

1. First apply all of the formatting options you require to a cell.  

 

2. Then choose Format|Style from the main menu. You will see the 
following dialog box: 

3. Type a new name in the Style Name box and click on Add to add more 
styles or OK to finish.  

You have now created a new style that can be used anywhere in the 
workbook. 



 

 

© Senan Solutions  Page 16 

Creating a Style using the Toolbar 

 

Another way to create a style is to use the Style box, which you can add 
to the Formatting bar using the toolbar customise techniques already 
covered. 

1. Once again, the first step is to format a cell exactly as you require it to 
look.  

2. Now click the mouse pointer on the drop-down arrow at the right hand 
end of the Style text box. This will highlight the current entry in the list. 

3. Type a new name for the style you have created and press Enter.  

4. The new style will be saved and will display in the list of styles whenever 
you click on the drop-down arrow. 

Re-defining a Style 

If you want to change the formatting options of any existing style: 

1. Select Format|Style from the main menu. The styles dialog box will 
display.  

 

2. Click on the drop-down arrow to the right of the Style Name box and 
select the style that you wish to amend.  

3. Now click on the Modify button; this will display the Format Cells dialog 
box. Change any options that you want and click on OK. 

Changing the Default Style 

When you create a new workbook, all cells will be assigned the Normal 
Style. If you make any amendments to this style it will affect the way that 
cells are formatted as a default. 
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Merging Styles from other Workbooks 

 

As mentioned already, any styles you create will not automatically appear 
in the list of styles in any new workbooks. To make a style available, you 
must copy it from one workbook to another. Both workbooks must be 
open for this procedure to work. 

1. Activate the workbook that is to receive the style and choose 
Format|Style from the main menu.  

 

 

2. From the dialog box, click on the Merge button. This will display the 
Merge dialog box; the name of the other workbook open should now 
appear in the list.  

4. If more than one workbook is listed, select the one you want.  

5. Now click on the OK button.  

6. All styles will be copied to the recipient workbook; if there are any 
duplicate style names between the two workbooks, Excel 2000 will ask 
whether you want these to be merged. 
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Adding Styles to the default Workbook 

 

No matter how many styles you create, only the default styles that are 
shipped with Excel 2000 will appear in the drop-down list of styles on the 
toolbar, unless you merge other styles in after opening a workbook. 
However, if you want a style to always be available in a new workbook, 
without having to perform a merge operation, you can apply the style to a 
special template. 

1. First open a new workbook and then define and name your new style or 
styles.  

2. Now ensure that all the cells are formatted using the Normal style.  

3. Select File|Save As from the main menu and change the Save File As 
Type entry to Template. 

4. Change the location in which you are going to save the template to the 
XLSTART subdirectory of Excel.  

5. (This is normally found on C:\Program Files\Microsoft 
Office\Office\XLSTART) 

6. You now need to give the template a name. To make this template the 
default which is always loaded up, give it the name BOOK.XLT.  

7. Click on the OK button and close down the workbook. 

8. Now click on the File|New toolbar button. A new workbook will be 
created; on the face of it, everything appears to be the same as normal. 
However, if you click on the Styles box drop-down arrow, you will now 
see that your new style is automatically in the list. 
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Applying Styles to Cells 

 

You can apply styles to cells either by : 

1. Selecting the cells and then choosing the style from the Styles drop-down 
box on the toolbar; or 
 

2. Selecting the cells and then choosing Format|Style from the main menu. 

Creating a Template 

 Create a file containing standard text, layout and formulae. 

Choose File, Save As 

In the Save File Type As box Choose Template 

 

 

 

Type a filename and choose Save.    

The file is saved with the .XLT extension - denoting a template 

Editing a Template File 

There will probably be occasions when you need to edit a template after it 
has been created and saved. If you choose File|Open from the main 
menu and select the template from the list in the normal way, you will be 
able to open the template. 

1. Select File, Open 

2. Select the template folder and highlight the file to be opened 

3. Click OK 
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Inserting Templates into Workbooks 

 If you want to insert a template into an existing workbook, instead of 
creating a new workbook, just right mouse click on a tab in the open 
workbook and choose Insert from the shortcut menu. 

 

 

 

You will now see that any templates that have been stored in the 
Templates sub-directory of Excel 2003 are shown in the list of sheet 
types that you can insert. Select the name of a template from this list and 
the sheets contained within the template are inserted into the current 
workbook as individual sheets. Any blank sheets contained in the 
template will also be inserted so it is sensible to delete any blank sheets 
from the template before you save it. 
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Startup Templates 

When Excel is executed it automatically looks for a sub-folder in 
C:\Program Files\Microsoft Office\Office called XLSTART.  Any files 
placed in this folder will be opened automatically when Excel is started.  
The start-up folder is especially useful for working with template and 
custom applications. 

If you create a template and save it as Book.xlt in the start-up folder it will 
automatically be loaded on start-up.  It will also load whenever you click 
on the new button.  This should be used for saving items such as default 
styles, column widths, etc. 

Default Start-up Location 

You can change the start-up folder location through Tools, Options, 
General.  By pointing the Alternate Start-up folder to a shared drive, a 
group of people can use the same defaults. 

 

 

 

Note: If you wish to change the font only for all future documents you 
should change the standard font under Tools, Options, General. 
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Templates and Startup files 

Many users of Excel frequently create very similar types of workbooks.  
Perhaps you may have an invoice workbook, or a purchase order 
workbook.  Each time you want to do a new invoice or a new purchase 
order, you could open the original workbook and choose Save Asé and 
save the new version under a new name and then start to make your 
changes.  This is a bit risky.  You may forget to use Save Asé and find 
that you have overtyped and lost some of the original data. 

A better approach would be to save the workbook as a Template and 
then it is not possible to accidentally overwrite the original. 

To create a template from an existing workbook 

1. Open the workbook and make any changes that you require.  You way 
wish to delete the numbers and format or delete some of the text.   

2. Delete any sheets that you donôt want to become part of the template.  To 
delete a sheet choose Delete Sheet from the Edit menu. 

3. When you are ready to save the workbook as a template choose Save 
Asé from the File menu and type in a relevant filename.   

4. Click the down arrow to the right of  the Save File as Type box at the 
bottom of the dialog box and choose Template.  

5. Excel automatically takes you to the template folder.  If you wish to save 
the template in this folder click the save button, if not choose another 
folder and choose Save. 

6. Close the Template 

Using a Template 

1. When you want to use the template choose New from the File menu, a 
list of templates appears.  Click the one you want to use and choose OK. 

2. If you called your template Invoice, the new workbook based on it will be 
called InvoiceI.  The template name always appears in the title bar at the 
top of the screen. 
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Inserting a Template into a Workbook 

 

If you want to insert a template into an existing workbook, instead of 
copying an existing worksheet and deleting the data, just right mouse 
click on a tab in the open workbook and choose Insert from the shortcut 
menu. 

 

 

 

You will now see all the templates that have been stored in the 
Templates folder. Select the name of a template from this list and the 
sheets contained within the template are inserted into the current 
workbook as individual sheets. Any blank sheets contained in the 
template will also be inserted so it is sensible to delete any blank sheets 
from the template before you save it. 
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Startup Templates 

 

When Excel is executed it automatically looks for a sub-folder in 
C:\Program Files\Microsoft Office\Office called XLSTART.  Any files 
placed in this folder will be opened automatically when Excel is started.  
The start-up folder is especially useful for working with template and 
custom applications. 

If you create a template and save it as Book.xlt in the start-up folder it will 
automatically be loaded on start-up.  It will also load whenever you click 
on the new button.  This should be used for saving items such as default 
styles, column widths, etc. 

Default Start-up Location 

You can change the start-up folder location through Tools, Options, 
General.  By pointing the Alternate Start-up folder to a shared drive, a 
group of people can use the same defaults. 

 

 

 

Note: If you wish to change the font only for all future documents you 
should change the standard font under Tools, Options, General. 

If you want to restore the original default template, either delete your 
template from the XLSTART folder, or move it to another folder.   
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Editing a Template 

 

Once you have created and saved a template you may wish to edit it at a 
later date.  To be able to edit the template you must open the original 
template.   

Microsoft Office automatically saves templates in the template folder 
structure that is used by all the office programs.  On a stand-alone 
system this is normally 
 ñC:\Program Files\Microsoft Office\Templatesò.  If your templates are not 
saved in this area you can find out where your templates are saved by 
loading Word and choosing Tools, Options, File Locations and looking 
to see what folder is set for User Templates.   

To edit a template: 

1. Choose Open, change to the template folder and Open the template. 

2. Make the required editing changes and Save and Close the template. 
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Outlining 

Introduction 

Worksheet Outlines in Excel provide a very powerful but simple means of 
creating summary reports based upon worksheets. With these summary 
reports you can display or hide as much detail as you wish. 

Worksheet outlining is especially useful when you want to share your 
summary reports with other people. They too can change the outline view 
to show or hide information. 

When you create an outline, or when Excel creates one for you 
automatically, your worksheet data is split up into groups with each group 
having its own summary data in an adjacent row or column. An outline 
can have up to eight levels or vertical or horizontal groups, but you may 
have only one outline per worksheet. 

Once an outline has been created, you will see a number of outline 
symbols on your worksheet. Outline symbols appear on small buttons 
along either the top of the worksheet, above the column headings, or to 
the left of the row headings. Depending upon the outline created, the 
symbols may appear along both worksheet axis. 

 

The picture above shows a worksheet that has been outlined: 
 

The buttons with numbers on them are the row and column level 
symbols. Clicking these buttons shows specific levels of outlining either 
across or down the screen. 

The plus and minus buttons will show and hide one level of detail 
respectively.  

The black bars that join the hide/show detail symbols mark one level of 
detail that would be hidden if the hide detail symbol were selected. 
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Creating an Outline 

There are three ways by which you can create an outline: 

 by using automatic outlining when data is organised in detail and 
summary rows or columns and the summary formulae refer to data 
immediately adjacent to them either above or to the left. 
 

 by using manual outlining where summary data is not directly adjacent to 
the detail or where there are no summary formulae. 
 

 by summarising lists where subtotals are required within the list. 

In addition to these methods, Excel itself also creates outlines 
automatically, for example after data consolidation with links specified. 

Automatic Outlining 

For automatic outlining to work there must be summary formulae on the 
worksheet and they must be to the immediately to the right of or below 
the detail area used in the formulae. 

Select the data that you want to outline, including the column and/or row 
totals. Then select Data|Group and Outline from the main menu. Click on 
Auto Outline from the sub menu. Your worksheet will now have outlining 
applied automatically and the various outline symbols will appear. You 
can now summarise at different levels. 

Manual Outlining 

If your worksheet data will not allow automatic outlining you can still apply 
outlining manually. 

To do this first select the columns or rows that you wish to group together 
within an outline. Make sure you select the whole column or row by using 
the column/row headers. 

Select Data|Group and Outline from the main menu and then select the 
Group command. Outlining will now be applied to your selection. You can 
repeat this procedure for any other areas of your worksheet you want 
grouped. 

Removing an Outline 

You can remove either the whole of an outline, or just a part of it, from 
your worksheet. 

To clear only part of an outline, select the row or column at which point 
you want the outlining to end. Select Data|Group and Outline from the 
main menu and then select the Clear Outline command. Any outlining in 
the column or row you selected and beyond will be removed. 

To clear all of an outline, select the whole. Select Data|Group and Outline 
from the main menu and then select the Clear Outline command. All 
outlining in worksheet will be cleared. 
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Creating a chart in Outline 

You can create a chart using only the rows and columns displayed in the 
outline. 

 

1. View only the rows and columns you wish to chart. 

2. Select cells for chart 

3. Create the chart using the wizard (or press F11) 

 

This creates the chart from the visible cells.  However, as you change the 
display of rows and columns the chart reflects the changes.  To stop the 
chart reflecting changes, you need to select visible cells only when 
charting 

Charting visible cells only 

First put select visible cells only button on toolbar.  

1. Customise toolbars 

2. Choose the Commands tab 

3. Select the Edit category 

4. Drag Select visible cells button on to a toolbar 

5. Select cells to chart 

6. Click on visible cells only button 

7. Create chart through wizard 

8. Display rows and columns 

9. The Chart does not change. 
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The View Manager 

You can create different views of a worksheet.  To do this you save 
different views of the same worksheet without having to save separate 
versions of the same worksheet.  You can then switch to any view 
whenever you want to display or print the information in a different way. 

The settings you can choose to save with a view include; print settings, 
row heights, column widths, the display settings, the selected cells, 
window size, position, panes frozen titles.  View settings are stored in the 
worksheet. 

Creating a View 

 

1. Display full document  

2. Create default view 

3. View, Custom Views, Add 

 

 

 

4. Type a view name 

 

 

 

5. Choose OK 

6. Promote or demote columns 

7. Create another view. 
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Displaying a view 

 

1. View, Custom Views 

 

 

2. Click on the view you wish to display 

3. Choose Show 

Deleting a view 

 

1. View, Custom Views 

2. Click on the view you wish to delete 

3. Choose Delete 
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Goal Seek 

Introduction 

Goal Seek can help you perform simple ñWhat Ifò analysis.  It is handy for 
problems that involve an exact target value that depends on a single 
unknown value.  Goal Seek can only change two cells, one must have a 
formula and the other a value.  Goal Seek will use the formula to change 
the value.  

To use Goal Seek choose Tools|Goal Seek from the main menu. You will 
see the following dialog box: 

 

 

 

Enter the details and click on the OK button or press Enter. The change 
specified by you will be made. 
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Scenario Manager 

Introduction 

Scenarios also enable you to do ñWhat Ifò analysis. A scenario is a set of 
values/numbers that Microsoft Excel saves and can substitute 
automatically in your worksheet. You can use scenarios to forecast the 
outcome of a worksheet model. You can create and save different groups 
of values on a worksheet and then switch to any of these new scenarios 
to view different results. 

For example, if you want to create a budget but are uncertain of your 
revenue, you can define different values for the revenue and then switch 
between the scenarios to perform what-if analyses. You can have up to 
32 changing cells per scenario and multiple scenarios per workbook. 

It is often easier to use and reuse Scenarios if the data in the worksheets 
is named. 

To use the Scenario Manager your data must have at least one set of 
input values (numbers you have typed in) and at least one set of output 
values, which depend upon the inputs (numbers produced as the result of 
a formula).  

Adding a Scenario 

To create a scenario, first make sure that your worksheet meets the 
requirements outlined above, i.e. at lease one set of input values and at 
least one set of formulae referring to the input values. 

Select Tools|Scenarios from the main menu. If the worksheet does not 
contain any scenarios, you will see the following dialog box: 
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Click on the Add button and you will see the following dialog box: 

 

Select the cells you wish to change by clicking in the Changing Cells text 
box and then dragging over the required cells. To select non-adjacent 
cells, hold down the Ctrl key whilst clicking on the cells. 

Having selected the changing cells, give the scenario a name, for 
example Best Case. You can also enter up to 255 characters of 
comment. When you click on the OK button, you will see the following 
dialog box: 

 

In this dialog box you can enter the values for the changing cells that 
match the chosen scenario. Once you have entered these you may click 
on the Add button. This takes you back to the Scenario dialog box where 
you can add another scenario if you wish. Continue this process until you 
have added all the scenarios you require. You can then click on the OK 
button and you will be returned back to the first dialog box. To return back 
to the worksheet click on the Close button. 
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Displaying Scenarios 

To see the results of each scenario, choose Tools|Scenario from the main 
menu to see the main Scenario dialog box. All existing scenarios will be 
listed in the dialog box together with the cells which will be altered by 
displaying the scenario, and any comments added at the time of creating 
the scenario. 

 

To display a particular scenario, simply highlight the required one and 
click on the Show button, or just double-click on the Scenario Name. The 
cells in the worksheet will alter to reflect the scenario. 

From this dialog box you can also add more scenarios or delete existing 
ones as well as editing any scenarios you have created already. 

Scenario Toolbar 

The quickest and easiest way to define and display scenarios is to add 
the Scenarios box to a standard or custom toolbar.  Follow the 
instructions below to create a Scenarios toolbar. 

 

1. Choose Toolbars from the View menu and then choose Customise.  
Excel displays the Customise dialog box. 

2. On the Toolbars tab click the New button. 

3. Excel presents the new toolbar dialog box, type Scenarios for the name 
of the toolbar and click OK. Excel displays a new empty Scenarios 
Toolbar. 

4. In the Customise dialog box click the Commands Tab. 

5. From the Categories list select the Tools item. 

6. In the Commands list scroll down and find the Scenarios command and 
the Scenario box and drag them to your new Scenario toolbar.   

7. Choose close to close the dialog box.   
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Merging Scenarios 

If you have created scenarios on more than one worksheet in a 
workbook, or in separate workbooks, it is possible to merge them 
together into one combined scenario. To do this select Tools|Scenario 
from the main menu and then click on the Merge button in the dialog box 
displayed. This will open up another dialog box where you can specify the 
locations of the scenarios you wish to merge together. When you have 
selected the worksheets click on the OK button. You will return back to 
the worksheet and the scenarios will be merged. 

Creating a Scenario Report 

It is sometimes useful to have a single report that provides details about 
all the scenarios you have created. To get such a report, select 
Tools|Scenario from the main menu and click on the Summary button in 
the dialog box. You will then see a dialog box. Choose the Scenario 
Summary Report Type and press Enter or click on the OK button. Excel 
will now add a new worksheet to your workbook that displays information 
about all the scenarios. 
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Worksheet Auditing 

Introduction 

Microsoft Excel provides a number of features that help you to track down 
problems on your worksheets. For example, you may have formulae that 
give unexpected or incorrect answers or a formula may display an error 
message. 

There may also be occasions when you wish to annotate your worksheet 
with notes to provide additional information on how a complex formula 
works. There may be other times when you need to find particular types 
of cells. 

Microsoft Excel allows you to do all of these things, and many more, 
through its Auditing features. 

Most worksheet auditing tasks can be started by using the  

Tools|Formula Auditing menu item or by using the Show Formula 
Auditing toolbar shown below: 

  

To switch the Formula Auditing Toolbar on choose the View, Toolbars, 
Formula Auditing  

Cell Precedents and Dependents 

 

Precedents are cells that are referred to by a formula, e.g. cell A3 could 
contain the formula A1*A2. Cells A1 and A2 are precedents of cell A3. 

Precedents can be either direct or indirect precedents. A direct precedent 
is a cell referred to by formula in the active cell. An indirect precedent is a 
cell referred to by a formula in a direct precedent cell or another indirect 
precedent cell. 

Dependants are cells that contain formulas which refer to other cells, e.g. 
cell A3 could contain the formula A1*A2. Cells A3 is the dependent of 
cells A1 and A2. 

Dependants can be either direct or indirect dependants. A direct 
dependent is a cell containing a formula that refers to the active cell. An 
indirect dependent is a cell that contains a formula that refers to a direct 
dependent cell or another indirect dependent cell. 

Tracing Cell Precedents and Dependents 

To trace the dependants or precedents of a particular cell you must first 
make that cell active by moving to it. You can then either select 
Tools|Formula Auditing from the main menu or click on the relevant 
toolbar button. 

Whichever method you choose, your worksheet will be amended so that it 
is marked with one or more blue arrows. These are called Tracers. 

Tracer arrows track data flow on your worksheet. They point in the 
direction of the data flow with the start point of the flow shown by a blue 
dot on the arrow. This marks either the direct precedent or dependent of 
the active cell. By clicking on the relevant toolbar button again the next 
level of precedents or dependants is shown. You can continue clicking 
until all precedents and dependants are displayed by tracer arrows. 
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Tracing External Cell Precedents 

When you click on the Trace Precedents toolbar button, special tracer 
arrows appear if the precedents are located in another workbook or 
another worksheet in the current workbook. 

The arrow will appear as a dashed black line with a worksheet icon at one 

end.  

Navigating Tracer Arrows 

Once you have drawn tracer arrows on your worksheet, you can navigate 
your way around the precedent and dependants by double clicking on the 
tracer line itself. This will either move your active cell to the dependent or 
precedent cell(s) or it will open the GoTo dialog box in the case of an 
external reference. 

Removing Tracer Arrows 

To remove all tracer arrows from a worksheet you can either click on the 

Remove All Tracers toolbar button or select Tools|Formula 
Auditing|Remove All Arrows from the main menu. 

Tracer arrows will also disappear if you close down the workbook, change 
the structure of the worksheet by inserting or deleting rows or columns, or 
if you alter any of the formulae referred to by precedents or dependants. 

Tracing Errors 

In addition to the precedent and dependant tracer arrows you can also 
trace the source of any errors on your worksheet in precedent cells. If you 
have a cell that returns an error message, e.g. #VALUE! or #NUM! By 
clicking on the Trace Error toolbar button you can draw a red tracer arrow 
to the source cells. You can then navigate through this tracer arrow until 
you have found the error. 

Note   Red arrows show cells that cause errors. If the selected cell is 
referenced by a cell on another worksheet or workbook, a black arrow 

points from the selected cell to a worksheet icon .The other workbook 
must be open before Microsoft Excel can trace these dependencies, 
however. 

Adding Comments to the Worksheet 

Annotating your worksheet is a good idea if you share your worksheet 
with others or if the worksheet is large and complex. By adding 
annotations the structure can be made clearer and additional information 
stored that you do not want to print. 

 

Adding a Comment 

To add a comment to a cell: Select the cell on which 
you wish to add a comment, either click on the New 
Comment button on the Reviewing Toolbar or select 
Insert|Comment from the main menu. Whichever 
method you choose you will see the following  
(yellow) box appear within the worksheet: 

When you have finished adding the note to the cell, 

Fred Bloggs: 
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click in the worksheet away from the cell containing the comment.   All 
cells that have notes attached to them can be displayed by clicking on the 
Show all comments  button on the Reviewing toolbar.  

 

Reviewing Toolbar 

Comment Indicators 

If a note has been added to a cell, you will see that a small red triangle is 
added to the cell on the worksheet. You can quickly view the contents of 
a cell by moving the insertion point over the cell. 

If you do not wish to display the note indicator on the worksheet, turn off 
the setting via Tools|Options. 

Deleting Comments 

To delete a single specific note select the cell containing the note.. Then 
click on the Delete comment button on the Reviewing toolbar. The note 
will be permanently deleted from the worksheet. 

To delete all worksheet notes select Edit|GoTo from the main menu and 
then click on the Special option. Select Comments from the list of options 
and click on OK. Excel 2000 will find and highlight all cells that contain 
comments. You can now choose Edit|Clear|Comments from the main 
menu. All the notes will be deleted. 

Printing Comments 

Cell Comments can be printed along with the cell contents. Select 
File|Page Setup from the main menu and then click on the Sheet tab. 
Now click on the Comments box.  

 

 

To print the cell references with the notes, select Row and Column 
Headings as well. Then choose Print. The Print dialog box allows you to 
print all notes on the worksheet or only selected notes. 
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Selecting Cells with Common Types of Content 

The F5 GoTo command is normally used to move your active cell 
location to a particular cell reference or to a named area. However, it can 
also be used to find and select all cells that contain a specific type of cell 
content. 

When you select Edit|GoTo from the main menu or press F5 the GoTo 
dialog box is displayed. Click on the Special button in this dialog box and 
you will then see the following dialog box: 

 

 

By choosing options from this dialog and then clicking on the OK button, 
Excel selects all the cells that match your choice on the current 
worksheet. You can look for all cells that contain constants or formulae or 
you could find all cells that are blank. 
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Linking Workbooks 

Introduction 

Linking workbooks provides an alternative to placing all the information 
relating to an application on separate sheets in the same workbook. 

When Excel 2000 workbooks are linked, any changes made in the source 
workbook will be immediately updated in the dependent workbook. Links 
can take many forms and can stretch across a number of workbooks. 

Advantages of linking workbooks 

 Systems require less memory because not all workbooks need to be 
opened simultaneously to carry out a particular task. 

 Systems are flexible and can be updated easily. Each component can be 
designed and tested without rebuilding the whole system. 

 Across networks, more people can work on the system simultaneously 
without problems of record locking. 

 Smaller workbooks are more efficient as they take a shorter time to 
recalculate. 

 Workbook components can be modified and used in other systems. 
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Creating a link between workbooks 

Creating a link between workbooks is a simple matter and can be 
achieved in a few different ways.  

At its simplest, you can link workbooks by opening up the files you wish to 
link and then building a formula by the point and click method, as you 
would build a formula within a single workbook. 

The second method, again very simple, is to use the Copy & Paste 
facility. You need simply copy the cells from the source workbook and 
paste into the dependent workbook. 

A third method is to create the link by typing the required information into 
a dialog box. Although this method is more prone to error, there may be 
occasions when it is necessary. 

Linking by Copy & Paste Special 

1. Open the source workbook and then select the cell that is to form the link. 
Select Edit|Copy from the menu or click on the Copy button on the 
toolbar. 

2. Open the target workbook and select the cell where the linked information 
is to appear. 

3. Choose Edit|Paste Special from the main menu. Do not click on the 
Paste toolbar button. 

 

You will now see the following dialog box: 

 
 

 

4. Click on the Paste Link button. 

The linked data will appear in the target workbook.  The formula will have 
the following format: 

=[filenamecontaining the source]sheetname!cell reference 
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='[RonMon 2006.xls]Sept 05'!$F$17 

Linking by Point & Click 

To carry out this procedure successfully you will need to open both the 
target and the source workbooks before doing anything else. You can use 
the Window|Arrange menu command to see both workbooks and make 
the procedure easier. 

Having opened both workbooks, move to the cell in the target workbook 
where the linking formula will appear. Start the formula in the normal way 
with an = sign, then activate the source workbook by clicking on it 
somewhere. Now click on the source cell. 

You will see that the formula in the target cell has picked up the address 
of the source cell and the fact that it is stored in another workbook. 
Continue building the formula in the normal way until you have finished. 

The linking formula will take on a format similar to the following: 

=FIRST.XLS!$B$4+SECOND.XLS!$B$4-THIRD.XLS!$C$8 

You will see that each cell reference is made an absolute reference by 
default. If this is not required, edit the formula by either deleting the $ 
signs or using the F4 key. 

Linking by Typing 

You can create links between workbooks without opening the source 
workbooks. This is sometimes necessary where the source file is too 
large to open up alongside your target workbook. Sometimes, even if you 
are able to open up both target and source workbooks it is quicker to type 
in the cell addresses than to click on them with the mouse. However, this 
is open to error and should only be done if you are happy to run the risk! 

 

If both workbooks are open you should type in the link formula in the 
following way: 
 

=[PATH\FILENAME.XLS]Sheetname!$A$1 

 

If only the target workbook is open you will need to type in the full path in 
addition to the above, e.g.: 
 

=óC:\EXCEL\TRAIN\[FILENAME.XLS]Sheetnameô!$A$1 

 

In this case you will need to enclose the path and filename within single 
quote marks. 
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Modifying Workbook Links 

You may at some stage after creating a link between workbooks need to 
modify the link. For example, if you rename or delete the source 
workbook or if you want the link to use another workbook and its data 
instead. 

To modify a link first activate the target workbook. Select Edit|Links from 
the main menu and you will see the following dialog box: 

 

 

 

Click on the Change Source button and select a new source workbook. 
The click on OK or press Enter. 
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Opening Target and Source Workbooks 

Once you have created a link between two workbooks, you do not need 
to open the source for the target to be updated. When you open up a 
target workbook you will see the following message: 

 

 

 

Select Update and the target workbook will be updated and display the 
latest information from the source workbook. 

 

You can choose to update references automatically by selecting 
Edit/Links and then clicking on the Startup Prompt button. Active ñDonôt 
display ghe alerts and update linksò.  When you next open a target 
workbook, the references will be updated automatically. 

If you want to open a source workbook whilst working within a target 
workbook simply select Edit|Links from the main menu and click on the 
Open button. The source workbook will be opened. 
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Embedding & Linking Objects - OLE 

Overview 

Object Linking and Embedding (OLE) has two components: linking and 
embedding.  The difference between them is crucial.  When you create a 
link to Excel data from another application, that application stores a set of 
pointers to the dataôs source in Excel; it does not store the data itself. If 
the source file changes the document containing the link is updated, 
either automatically or on demand. In contrast when you embed Excel 
data in another application, a copy of the embedded data is incorporated 
into the receiving document, and this embedded information is not 
updated if the source data changes. 

Typically, embedded data requires more disk space; linked data requires 
less disk space, but also requires that the source document remains 
available.  

Embedding an Excel Chart or Worksheet range in a Word 
document 

1 Load Word and open the document you wish to embed the chart or 
worksheet range in. 

2 Load Excel and open the worksheet which contains the data you wish to 
embed.  Select the chart or worksheet range and click the Copy button.   

3 Switch back to Word, position the insertion point where you want the 
chart to appear and then choose Paste.  

Editing an Embedded Object 

You can edit an embedded object directly in the Word document.  When 
you double-click an embedded object, it opens the original application so 
that you can edit the object.  In other applications, some of the menus 
and toolbars in Word are temporarily replaced by those in the original 
application. 

To edit an embedded object directly: 

1. Double-click the embedded object. 

2. Edit the object. 

3. Do one of the following: If you are editing the object in a separate 
application window, choose either Exit or Quit from the File menu to 
return to Word. If you are editing the object in an application that 
temporarily replaces the Word menus and toolbars, click anywhere 
outside the embedded object to return to Word. 

 



 

 

© Senan Solutions  Page 46 

Linking an Excel Chart or Worksheet range to a Word 
document 

 

1. Load Word and open the document you wish to embed the chart or 
worksheet range in. 

2. Load Excel and open the worksheet which contains the data.  Select the 
chart or worksheet range and click the Copy button.  DO NOT close the 
worksheet or exit Excel, if you do you will not be able to create the link.  

3. Switch back to Word.   

4. Position the insertion point where you want the chart or worksheet to 
appear. 

 

 

Choose Paste Special from the Edit menu, click the Paste Link button 
and click on OK. 

 

Editing a Linked Object 

When you link an Excel chart or worksheet range to a Word document 
Word displays a picture of the object in the Word document (this is a field 
code), the actual object exists in Excel.  So therefore the simplest way to 
edit a linked object is to open the worksheet in Excel and edit the object.  
When you return to Word and next open the file which contains the linked 
object Word will update the object to reflect the current object in the Excel 
worksheet. 

If you double click a linked object in Word, Windows will load Excel and 
open the worksheet which contains the object. 

 






















































